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Welcome

Welcome
Thank you for purchasing the controller.

This User Manual explains how to run print cycles on the machine to which the
controller is connected. It also gives precautions that you should review before
attempting to use the controller. Therefore, first read this manual carefully and
thoroughly, and then keep it close at hand so you can refer to it whenever it becomes
necessary.

When operating the controller and machine, follow the instructions given in this
manual and in the one for the machine. Do not attempt to touch any part that is not
covered in these manuals. To prevent possible hazardous conditions, never attempt
to disassemble or alter any pieces of equipment.

Some of the screens shown in this manual may look different from what you will
see in actual applications.

Trademark acknowledgments

Minolta is a registered trademark of MINOLTA CO., LTD.

Windows and Windows NT are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

IBM and PC/AT are registered trademarks of International Business Machines
Corporation.

PCL is a registered trademark of Hewlett-Packard Company.

All other products or brand names are trademarks or registered trademarks of their
respective companies or organizations.
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Naming of equipment and functions

Naming of equipment and functions

Different names are used by the printer driver and the machine to identify the same

piece of equipment or the same function. Note the following.

Equipment names

Printer driver Machine
Finisher Finisher FN-115
Booklet Finisher Finisher FN-7
Punch Unit Punch kit PK-3
Punch & Z-Fold Unit Z-Fold kit ZK-2

Cover Inserter

Cover Inserter C

Trimmer Unit Trimming unit TMG-2
Manual Feed Multi-sheet Bypass Tray
LCC Large Capacity Cassette C-40

Large Capacity Cassette C-404

Function names

Printer driver Machine
N-up Nin1l
Booklet Left Binding Left Binding
Booklet Right Binding Right Binding
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1. Features of the printer driver

1. Features of the printer driver

Features of the printer driver

This controller is an image controller designed to use the machine as a printer,
allowing you to print documents directly to the machine from a computer to which
the controller is connected. The printer driver, which is used during printing, is
equipped with various functions that make the most out of the features of the
machine and enable you to use the same functions as those offered by the machine.
When actually running a print cycle, you can specify various functions of the
machine on your computer screen.

NOTES

» Some functions offered by the machine cannot be combined, such as Cover
Page and OHP Interleaving, and some others may not be possible because of
the paper size involved. The functions that cannot be selected appear dimmed.
Furthermore, if functions that are incompatible with each other are specified,
the Conflicts dialog box will appear, prompting you to change the settings.
When this dialog box appears, check the details and reselect the functions to
ensure function compatibility.

Some settings that are refused by the machine because of restricted
combinations of different functions can at times be accepted by the printer
driver. If a print command is issued from the personal computer with such
settings made, the machine will not produce the output correctly: Be sure to
make correct settings.

Various printing functions

» Makes copies that are sorted into complete sets of the original document or
grouped into uncollected groups, each containing copies of one page of the
original document. O p. 3-16
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1. Features of the printer driver

» Prints two pages of the original document on both the front and back sides of
single sheet of paperd p. 3-7

Rl Y 12l

46080008AA 46080009AA

Chapter 1

Long Edge Binding Short Edge Binding

» Enlarges or reduces the originall p. 3-15

Before Using the Printer Drivi

e | > @it

» Prints two pages or four pages of the original document on a single sheet of
paper.
A maximum of 16 pages of the original document can be printed on a single
sheet of paper.J p. 3-6

11490004AA

46680001AA

4 up

» Prints four pages of the original document on both the front and back sides of a
single sheet of paper, which can be folded into a booKletp. 3-7

1 ﬁ

46080011AB
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1. Features of the printer driver

» Places text (a watermark) in the backgrournd.p. 3-23

46080001AA

» Prints complete sets of the original document, stapled togefhgr. 3-12

12 fi]

46680002AA

By using sorting, you can make complete sets of documents for immediate
delivery without having to do any further processing.

]
122 4= (1]
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1. Features of the printer driver

» Prints the cover on a different type of paper (such as colored paper).
0 p. 3-10

Chapter 1

11490013AA

» Prints on OHP transparencies. You can also insert interleaves, either blank or
printed with the same contents as those on the OHP transparehcies3-11

Before Using the Printer Drivi

11490017AA

» Folds copies during finishingD p. 3-13

40140001AA
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1. Features of the printer driver

Administrative functions

Account Code
« The E.C.M. (E.K.C.) function can be used as if the machine was used as a
copier. 0 p. 3-20

1. Select the Account Code check box on the Job Management tab of the printer
driver.

2. Type the appropriate number in the Access Number box.
The job will be printed, and the number of prints will be counted for the
specified account.

= @
Security
¥ Account Code ||

Access Number ; [0- 93393339] _>
000ma34 —

—

—

L, LT

C40270204CA

Lock Job

» Printing of confidential documents may be withheld until a legitimate password
is entered on the machinél p. 3-21

1. Select the Lock Job check box on the Job Management tab of the printer driver.

2. Type the password in the Password box.

3. From the control panel of the copier, type the password.
The job will be printed.

W Lock Job N
Passuard ; [ ] ’ I ’
lxxxxxxxx—

C40270203CA
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1. Features of the printer driver

Wait

The copier stops automatically before it prints the received image. 3-22

1. Select “Wait” from the Job Life list on the Job Management tab of the printer

driver.

2. On the control panel of the copier, the PRINTER CHECK MODE screen

appears. Press the [Start] key.
The job will be printed.

Job Schedule N
Jah Lite [Past Rip) > r >
’7 /Al -~ —

C40270205CA

Proof

|

The copier stops automatically after printing a set of images of a job.
O p. 3-22

Select “Proof” from the Job Life list on the Job Management tab of the printer
driver.
Only a copy of the job will be printed.

On the control panel of the copier, press the [Start] key.
All jobs will be printed.

Job Schedule s 1 s || @
Job Life [Paost Rip)

— —

@
=
0
@
&

i
C40270206CA
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2. Installing the printer drivers

2. Installing the printer drivers

Installing various printer drivers

To make 100% use of the functions offered by the machine to which the controller
was added, install the attached printer drivers on your computer. The controller is
furnished with the following printer drivers:

» PCL6 printer driver for Windows 98/Me
e PCL6 printer driver for Windows NT 4.0
e PCL6 printer driver for Windows 2000/XP

Install the printer driver suitable for the operating system that runs on your
computer. For installation procedures, see the relevant page as detailed below:

Installing the Windows printer driver:
Windows 98/Me 0O p. 2-2
Windows NT 4.0/2000/XP0O p. 2-9
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1. Windows 98/Me

Operating environment

This section explains the required environment for the printer driver.
Before installing the printer driver, make sure that your computer meets the
following requirements. If it doesn’t, the printer driver may not function properly.

Personal computer IBM PC or compatible with an 80486, AMD, ar
Pentium processor

Operating system Windows 98 (English)
Windows Me (English)

Memory 32 MB or more

I/O interface Network 10/100BaseT (UTP)

»  Windows NT 4.0/2000/XP
For the operating environment and installation procedure for the Windows NT
4.0/2000/XP printer driver, see p. 2-9.
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1. Windows 98/Me

Installation
This section explains the installation procedure for the Windows 98 printer driver.

NOTES

« Before starting to install the printer driver, be sure first to quit all other
applications.

* When installing the printer driver for Windows Me, read “Windows 98" as
“Windows Me”.

1. Click the [Start] button. In the menu that appears, point to “Settings”, and then
click “Printers”.

2. The Printers window will appear. Double-click the Add Printer icon.
3. Click the [Next>] button to start the Add Printer Wizard.

Add Printer Wizard

Thiz wizard will help you ta install your printer quickly and
eazily.

To begin inztalling your printer, click Mext.

Caticel

4668P003CA
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4. A dialog box that allows you to select the type of connection for the printer will
appear.
Select “Local printer”, and then click the [Next>] button.

Add Printer Wizard

How iz thiz printer attached to your computer?

IFitis directly attached ta your computer, click Local
Printer. If it is attached to another computer, click Mebwork
Printer

ﬁ " Metwork printer

.

| —

< Back I Mext > I Cancel

4668P004CA

NOTES

» The printer is actually connected to the network. However, since other network
settings are required, the printer driver is temporarily installed as for a local
connection.

» To make settings for using the network, it is recommended that you read the
Pi8500Pro Getting Started manual, which comes with the controller.

5. A dialog box will appear, prompting you to select the manufacturer and model of
your printer. Click the [Have Disk...] button in the lower right part of the dialog box.

Add Printer Wizard

K“? Click the manufacturer and model of pour printer. If your printer came with an
it installation disk, click Have Disk. If your printer is not listed, consulk your printer
documentation for a compatible printer

Manufacturers:

Set 10005F +2013.108
AGFA-AccuSet 10005F +52.3
AGFA-AccuSet 1500
AGFA-AccuSet 15005F w2013.108
Bull AGFA-AccuSet 800

C-ltek LI AGFA-ArmS et BONSF »2013 108 LI

Have Disk...

< Back I Mext > I Cancel |

4668P005CA
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6. The Install From Disk dialog box will appear. Insert the controller driver CD-
ROM, included with the controller, in the CD-ROM drive of your computer.

7. In the Copy manufacturer’s files from box, type the path of the driver to be
installed. (In the example, the letter of the CD-ROM drive is |.)
To install the driver for Windows 98/Me, type “I:\PrinterDrive\PCL6\W98Me”".

Install From Disk x|

Inzert the manufacturer's installation disk into
the drive selected, and then click OK.

Cancel

Copy manufacturer's files from:

|:%PrinterDiriver\PCLEYW 38Me j Browse...

C4027P216CA

8. The Printers list will appear.
Select the driver to be installed, and then click the [Next>] button.

9. A dialog box that prompts you to select the port will appear. Select a port, and
then click the [Next>] button.

Add Printer Wizard

Click the port you want to uze with this printer, and then
click Mext.

Available ports:

COM1: Communications Port
COM4: Infrared Serial [COM] Port
Creates a file on disk

Infrared Printing [LPT] Port

LConfigure Port.... |

< Back I Mext > I Cancel |

4668P009CA

NOTES
» The selected port will be changed later.

Chapter 2
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1. Windows 98/Me

10. A dialog box that asks you to confirm the printer name will appear. Check the
printer name. If you want to designate this printer as the default printer, select
“Yes".

Click the [Next>] button.

11. A dialog box that allows you to select printing of a test page will appear.
Select “No”, and then click the [Finish] button.

12. Installation will start.
When the installation is completed, the corresponding icon will be added to the
“Printers” window.

B3 Printers 9 ] B

J File Edit “iew Go Favorites Help ﬁ

Add Printer Minolta
Pig500P o
PCLE

-

=
4] | v

C4027P217CA

NOTES
* You cannot print with the local port setting. Use the following procedure to
make the settings for the printer driver.

13. Right-click the new printer icon and select “Properties” from the menu.
14. Click the “Details” tab in the dialog box that appeared.

15. Click the [Add Port] button.
The Add Port dialog box appears.

16. Select “Network”, and then click the [Browse] button.

17. Select the printer on the network, and then click the [OK] button.

NOTES
« If the desired printer does not appear on your network, refer to the
Pi8500Pro Getting Started manual or consult the network administrator.

18. Click the [OK] button twice.
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Making general settings before using the printer

The printer driver requires setting items that are common to all print jobs, including
the port to which the printer is connected and any optional devices configured wi
the machine. These settings must be made using tabs available in a Properties di
box after the printer driver has been installed or whenever the operating
environment changes.

The most common settings were made when the printer driver was installed, so you
do not usually need to change them. Some items must, however, be changed in thg
following cases. =

Cases where changes are necessary Applicable tabs

* You want to add a comment to distinguish the prinfeGeneral
from others.

* The connection port has been changed on the Details
computer.
* You want to change the conditions for the display df a
timeout error.
* You want to designate a port to which the machine is
connected via a network. (This setting must be made
on a computer that is connected to the controller via a
network.)

Installing the Printer Dr

* The setting is not related to printing. Color Management

* You want to share the machine with other computerSharing
connected to the same network. (This setting must be
made on the computer directly connected to the

controller.)

* You want to change the setting in the Minolta Setup
Pi8500Pro PCL6 Properties dialog box. For details, Paper
see Chapter 3. Quality

Device Options Setting
Job Management
Overlay
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1. Windows 98/Me

Displaying a Properties dialog box

There are two different ways to display a Properties dialog box. The contents of a
particular dialog box differ slightly depending on how you access it. Select the
appropriate one according to your need.

(1) To display a Properties dialog box from the Printers folder
(2) To display a Properties dialog box from an application menu
Below are the detailed procedures for each approach.

Displaying a Properties dialog box from the Printer folder
1. Click the [Start] button, point to “Settings”, and then click “Printers”.

2. Right-click the Minolta Pi8500Pro PCL6 icon.

3. Click “Properties” on the menu that will appear. This will display the Properties
dialog box.

This method allows you to set the environment in which you will use the printer.
The settings made through this method are valid in all applications.

Displaying a Properties dialog box from an application menu
1. Click “Print...” on the File menu of the application.

2. Make sure that “Minolta Pi8500Pro PCL6" is the listed printer name. Otherwise,
click [ ¥], and then select “Minolta Pi8500Pro PCL6" from the list that will appear.

3. Click the [Properties] button. This will display the Properties dialog box.

This method allows you to set the number of copies and type of paper for each
document.

Note that the settings made in the Properties dialog box accessed through the
application are valid only for that particular application.

TIPS
» To make settings in the Device Options Setting tab, display the Properties
dialog box from the Printers folder.

NOTE

The steps to display a Properties dialog box may differ depending on the
application. Follow the correct procedure according to the application. The
procedure above is based on the WordPad application.
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2. Windows NT 4.0/2000/XP

Operating environment

This section explains the required environment for the printer driver.
Before installing the printer driver, make sure that your computer meets the
following requirements. If it doesn’t, the printer driver may not function properly.

Personal computer IBM PC or compatible with an 80486, AMD, ar
Pentium processor

Operating system Windows NT 4.0 (English)
Windows 2000 (English)
Windows XP (English)

Memory 32 MB or more (Windows NT 4.0/2000)
64 MB or more (Windows XP)

I/O interface Network 10/100BaseT (UTP)

*  Windows 98/Me
For the operating environment and installation procedure for the Windows 98/Me
printer driver, see p. 2-2.

Chapter 2
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2. Windows NT 4.0/2000/XP

Installation
This section explains the installation procedure for the Windows XP printer driver.

NOTES

« Before starting to install the printer driver, be sure first to quit all other
applications.

 Before starting to install the printer driver, log in as Administrator.

» The installation screens differ between Windows XP and Windows NT 4.0/
2000.

* When installing the printer driver for Windows NT 4.0 or Windows 2000, read
“Windows XP” as “Windows NT 4.0/2000". Three function or item names are
given as applicable if they differ between the three operating systems.

1. Click the [start] button. On the menu that appears, click “Printers and Faxes”.
* For Windows NT 4.0/2000, click the “Start” button, point to “Settings”, and
then click “Printers”.

2. The Printers and Faxes window will appear. Click the “Add a printer” icon.
* For Windows NT 4.0/2000, double-click the “Add Printer” icon in the Printers
window.

3. Click the [Next>] button to start the Add Printer Wizard.

Add|Printen Wizard

Welcome to the Add Printer
Wizard

This wizard helps you install & printer or make printer
cormestions:

If you have a Plug and Play printer that connects

) tvough 3 USE pat [or any clher hot phggable
port, such as [EEE 1394, infrared, and 0 on), you
do not need b use this wizard. Click Cancel to
close the wizard, and then plug the printer's cabls
into your computer o point the: printer toward your
computer's infrared port, and tum the: printer on.
Windows wil automatically install the printer for you.

To continue, click Next

C4027P201CA

NOTE
This step is skipped in Windows NT 4.0.
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4. A dialog box that allows you to select the type of connection for the printer will
appear. Select “Local printer attached to this computer”.
* For Windows NT 4.0, select “My Computer”.
For Windows 2000, select “Local printer”.

NOTES

» The printer is actually connected to the network. However, since other networl
settings are required, the printer driver is temporarily installed as for a local
connection.

» To make settings for using the network, it is recommended that your read the
Pi8500Pro Getting Started manual, which comes with the controller.

Add Printer Wizard

Local or Metwork Printer

The wizard needs to know which type of printer to set up. V

Select the option that describes the printer you wart to use:
@1 acal piiier afiached ta (s computer

[ Automaticall detect and install my Flug and Play printer
O A network, printer, o a prirter attached to another computer

§ ) Tosetup anetwoik pinter thatis ot atached o & pit server,
\) use the "Local printer opti

C4027P202CA

5. Click the [Next>] button.

6. A dialog box that prompts you to select the port will appear. Select a port, and
then click the [Next>] button.

Add Printer, Wizand

Select a Printer Port

Computers communicate with printers though ports V

Select the part you want your printer o use. If the part is not listed. you can create a
e POt

[ONEYSY LML | P11 (Recommended Printer Porl]

Note: Most computers use the LPT1: port to communicate with a lacal printer.
The: connector for this part should look something ke this:

S
o,

&ZE e =

O Creats a rew pott

C4027P203CA

NOTES
» The selected port will be changed later.

Chapter 2
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7. A dialog box will appear, prompting you to select the manufacturer and model
of your printer. Click the [Have Disk...] button in the lower right part of the
dialog box.

Add Printer Wizard

Install Printer Software O
The manufacturer and model determine which printer software to use. Qs’

Js Select the manufacturer and model of your printer. IF your printer came with an installation
disk, click Have Disk. If your printer is not listed, consult your printer documentation for
compatible printer software.

Manufacturer || Printers o
i aGFAAceSet vE2 D
i\ps" ¥ BBFA-ACCUSEISE vE23
AE§|§ 5 aBFA-AccuSst 800
APS-PS | ﬁ.ﬂﬁ Fé-fcouSet BODSF v52.3 3
[ This diiver is digitally signed. [ windows Update ] [ Have Disk... ]

Tell me why driver signing is important

I < Back ” MNext > 1[ Cancel ]

C4027P204CA

8. The Install From Disk dialog box will appear. Insert the controller driver CD-
ROM, included with the interface kit, in the CD-ROM drive of your computer.

9. In the Copy manufacturer’s files from box, type the path of the driver to be
installed. (In an example, the letter of the CD-ROM drive is I.)
To install the driver for Windows 2000/XP, type “I:\PrinterDriver\PCL6\
W2kXp”.
To install the driver for Windows NT 4.0, type “l:\\PrinterDriver\PCL6\Nt4".

Install From Disk @

Inzert the manufacturer's installation disk, and then
= make sure that the comrect drive is selected below.
LCopy manufacturer's files from:
I:\PrinterDriver\PCLEVW 2KXp v
C4027P205CA

10. Click the [OK] button.

11. The Printers list will appear.
Select the driver to be installed, and then click the [Next>] button.
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12. Follow the instructions that appear on the screen to complete the installation.
When the installation is completed, the corresponding icon will be added to the
“Printers and Faxes” window.

*® Printers and Faxes Elﬁlgl

¢ File  Edt  Wiew Favorites Tools  Help h

N
S
Q
3
Q
©
=
O

~

| @ rinolz Fiesooera PaLs
=

Printer Tasks

Ready
[2] Add a printer

&2 Set up Faxing

See Also

L?J Troubleshoat prinking
b
v *

@) Get help with printing

C4027P207CA

NOTES

* You cannot print from this printer with the local port setting.
Make network port settings according to instructions in the Pi8500Pro Getting
Started manual or from the network administrator.

Installing the Printer Drive
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2. Windows NT 4.0/2000/XP

Making general settings before using the printer

The printer driver requires setting items that are common to all print jobs, including
the port to which the printer is connected and any optional devices configured with
the machine. These settings must be made using tabs available in a Properties dialog
box after the printer driver has been installed or whenever the operating
environment changes.

The most common settings were made when the printer driver was installed, so you
do not usually need to change them. Some items must, however, be changed in the
following cases.

Cases where changes are necessary Applicable|tabs Remarks
* You want to add a comment to distinguish the
; General
printer from others.
* You want to share the machine with other
computers connected to the same network. Sharin
(This setting must be made on the compute 9
that is directly connected to the controller.)
* The connection port has been changed on the
computer.
* You want to change the conditions for the
display of a timeout error. Ports
* You want to designate a port to which the
machine is connected via a network. (This
setting must be made on a computer that is
connected to the controller via a network.)
* You want to restrict conditions under which Function avail-
the printer can be used. able only in
- . Advanced .
* You want to change spool condition settings| Windows 2000/
* You want to change OS-dependent settings XP
* This setting is not related to printing. Function avail-
Color able only in
Management | Windows 2000/
XP
* You want to specify a time frame for maching Function avail-
operation. . able only in
Scheduling Windows NT
4.0
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2. Windows NT 4.0/2000/XP

Cases where changes are necessary Applicable|tabs Rema
You want to restrict access to the machine. Function avail-
You want to check the machine users’ Securit able only in
accounts. y Windows NT

4.0

You want to make settings for optional
equipment installed on the machine.

Device Options
Setting

ks

Chapter 2
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2. Windows NT 4.0/2000/XP

Displaying a Properties dialog box

There are two different ways to display a Properties dialog box. The contents of a

particular dialog box differ slightly depending on how you access it. Select the
appropriate one according to your need.

(1) To display a Properties dialog box from the Printers folder
(2) To display a Properties dialog box from an application menu
Below are the detailed procedures for each approach.

Displaying a Properties dialog box from the Printer folder
1. Click the [Start] button, and then click “Printers and Faxes”.

2. Click the Minolta Pi8500Pro PCL6 icon.

To display the General tab:
3. Click “Properties” on the File menu.

To display the Printing Preferences dialog box:
3. Click “Printing Preferences...” on the File menu. This opens the Minolta
Pi8500Pro PCL6 Printing Preferences dialog box.

This method allows you to set the environment in which you will use the printer.
The settings made through this method are valid in all applications.

NOTE
Since different function and item names are used for Windows NT 4.0, read
“Printing Preferences” as “Document Defaults”.

Displaying a Properties dialog box from an application menu

For Windows XP

1. Click “Print...” on the File menu of the application.

2. Make sure that “Minolta Pi8500Pro PCL6" is the listed printer name on the
General tab.

For Windows 2000

1. Click “Print...” on the File menu of the application.

2. Make sure that “Minolta Pi8500Pro PCL6" is the listed printer name on the

General tab. Otherwise, clicl¥[], and then select “Minolta Pi8500Pro PCL6"
from the list that will appear.
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For Windows NT 4.0
1. Click “Print...” on the File menu of the application.

2. Make sure that “Minolta Pi8500Pro PCL6" is the listed printer name. Otherwisg
click [ v], and then select “Minolta Pi8500Pro PCL6” from the list that will
appear.

3. Click the [Properties] button. This will display the Properties dialog box.

This method allows you to set the number of copies and type of paper for each
document.

Note that the settings made in Properties dialog box accessed through the
application are valid only for that particular application.

TIPS
To make settings in the Device Options Setting tab, display the Properties dialog
box from the Printers folder.

NOTE

The steps to display a Properties dialog box may differ depending on the
application. Follow the correct procedure according to the application. The
procedure above is based on the WordPad application.

Chapter 2

Installing the Printer Drive
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1. Properties settings

1. Properties settings

Description of each Properties tab

The tabs in the Properties dialog box allow you to make the following settings. For a

detailed description of each tab, see the corresponding reference page.

Properties tab

Outline of settings that can be made

Reference

Setup

Allows you to select the paper take-up tral
and the paper exit tray.

Also allows you to set high-level printing
functions, such as two-sided printing, book
let creation, N-up printing, OHP interleav-
ing, Cover Mode, Staple, and Folding.

y [ p.3-6

Paper

Allows you to set basic printing conditiong
such as number of copies, paper size, prir
orientation and print zoom ratio.

Also allows you to set functions related to
sorting.

,0 p.3-14

Quality

Allows you to set the resolution.

0 p.3-19

Device Options
Setting

Allows you to make settings for optional
equipment installed to the machine.

O p.3-3

Job Management

Sets the E.C.M. (E.K.C.) function.
Allows you to lock a print job.

0 p.3-20

Overlay

Allows you to make watermark settings.

0 p.3-23

age
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2. Device Options Setting tab

Functions of the Device Options Setting tab

This Properties tab allows you to make settings for the options installed to the
machine. Be sure to select the options correctly. Otherwise, some functions may be
unusable or printing errors may occur. The settings must match the machine
configuration.

There is no need to make settings for any options that are fitted to your machine

3

~
o

that are not mentioned in the Installable Options list. 5
=
g
Minolta Pi8500Pro PCLE Properties c
General I Details | Caolor Management I Sharing I Setup I Paper I O
Quality Device Options Setting Job Management | Dverlay
(l) ~ Easy Set i Device Optiar
- Installable Options : E‘
- =
Save. I "q-')
wn
[%)]
Q
=
j
o =0 Sidd] Hemayve [}
Q.
) |pstalled Options 9
| LCC o
—, Trimmer Unit
Booklet Finisher
Purch & Z-Fold Unit
Cover Inserter
™ Page Layout
1% Printer Fi
rinter Figure about., | (2)
Ok Cancel Apply I Help I

C4027P208CA

(1) Device Options
Select the options installed to the machine.
« Installable Options ~ This is a list of options that can be installed. Select the
desired options from this list.
Available settings: LCC, Trimmer Unit, Booklet
Finisher, Finisher, Punch & Z-
Fold Unit, Punch Unit, Cover

Inserter
» Add Pressing this button adds the selected option.
* Remove Pressing this button removes the selected option.
* Installed Options This is a list of options that are currently installed.

Select it when you wish to remove an option.

(2) About...
Click to display the manufacturer and version number of the printer driver.
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3. Functions common to various Properties tabs

3. Functions common to various Properties tabs

Functions common to various Properties tabs
These functions are common to various Properties tabs, from Setup to Overlay.

Minolta Pig500Pro PCLE Properties 2] x]
General | Detals | ColorManagement | Shaing | Sewp | Paper |
Qualty Device Options Setting | Job Management | Overlay
~Eaw ~Deice Optian
i = Installable Options
(_‘]_) IR Firisher
Save Punch Urit
. T Remove
Installed Options
&
==
= i it
) il ookl Firiher
Cover
" Page Layout
& Prirter Figure
Apout. |

oK. Eoredl doy | Wb |

C4027P208CA

(1) Easy Set
Allows you to recall and use settings stored in the Properties tab.

» Easy Set list Allows you to select a group of settings stored for the
Properties tab.
» Save (Delete) Allows you to save (or delete) the settings in the

Properties tab. When you click the [Save] button, the
settings in the Properties tab are saved and the Save
Easy Set Name dialog box will appearp. 3-5

When you click the [Delete] button, the current group
of stored settings is deleted.

NOTES
» Depending on the environment used, contents of Save/Delete will be different.
U p. A5

TIPS

« If any setting of the current group has been changed, the [Save] button will
appear.

« If the settings currently displayed are those of a stored group, the [Delete]
button will appear.
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(2) Paper preview/Machine preview

Allows you to display and change the paper preview and machine preview.

» Page Layout The layout of the print data of a single page is
displayed as an image. This allows you to check the
status for N-up printing and two-sided printing, for
example.

* Printer Figure When the paper take-up tray and paper exit tray have
been selected, the trays are displayed in green.

Functions of the Save Easy Set Name dialog box

Used to save print settings.
Before clicking the [Save] button, check all settings for the Properties tab.

Eazy Set Mame :
(1) 4'4— Cancel |
Help |

4668P049CA

(1) Easy Set Name
Add a name to the group of stored settings.
* Number of registrations Different depending on the environment used
0 p.A5
* Number of characters Max. 10 characters

Chapter 3

Properties Setting
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4. Setup tab

Functions of the Setup tab

Allows you to make settings for the paper take-up tray, paper exit tray and various
high-level printing functions.

Chapter 3

Properties Setting

Minolta Pi8500Pro PCLE Properhies
Guality I Device Options Setting I Job Management I Overlay |
General I Detals I Color M anagement I Sharing Setup I Paper
i Easy Set - N-up . PaperSource
1 Paper Source :
A i |
@ =i T 4
5 = | Erder e
EhiE I Media Type
HFm EhEL I lhl
i i Duplex / Booklet Detail of Paper Source . I
(2) I Off j — Output Setting—————————————
Primary Tray -
rImage Repeat
(3) a3 -
1+ Page Lapout
" Printer Figuie Detail Of Dutput Setting
oK I Cancel | Aoy I Help |
C4027P209CA
(1) N-up

Outputs multiple pages of the original document on one sheet of paper.
Select an N-up number.
Available settings: Off, 2 up, 4 up, 6 up, 9 up, 16 up
Adds a border to the layout.

e N-up

* Border Line

* N-up Style Allows you to select a printing layout.
Fp==T—=n1 Fr==T== p==—r—=1 rF==T==
BEEE T BEER P01
1 1 1 1 1 1 1 1 1 1 1 1
F-—+—-A F——+—— F-—+—-A F——+——
| | | | | | | | | | | |
4 4rel ed a4 E
Horiz. Horiz. Vert. Vert.
Ascending Descending Ascending Descending

4668P051CA

[0 See p. 1-3 for an illustration.
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NOTES

« If the original document for a print job contains pages of different sizes and/or
different orientations, pages may be partially cut or overlap each other.

 This setting is not available if Custom Paper is used.

TIP
The print layout is displayed in the Page Layout area.
(2) Duplex / Booklet
Specifies two-sided printing and booklet printing.
» Off No setting
« Short Edge Binding Two-sided printing that allows for the short edge to
be bound
» Long Edge Binding Two-sided printing that allows for the long edge to
be bound
* Booklet Left Binding  Four pages are printed on both sides of a single

sheet of paper so that when the sheet is folded in the
middle it forms a left-bound booklet.

» Booklet Right Binding Four pages are printed on both sides of a single
sheet of paper so that when the sheet is folded in the
middle it forms a right-bound booklet.

[0 See p. 1-3 for an illustration.

NOTES

« If the original document for a print job contains pages of different sizes and/or
different orientations, pages may be partially cut or overlap each other.

» Two-sided printing and OHP Interleaving are not available simultaneously.

TIPS

» Two-sided printing can be performed on paper of the following sizes: Letter,
Letter-R, Legal, A3, A4, Ad4-R, A5, B4, B5, B5-R, Invoicel11F4-1, F4-2,
F4-3, and F4-4.

» Short Edge Binding, Long Edge Biding, Booklet Left Binding and Booklet
Right Binding will be displayed in the Page Layout area.

Chapter 3

Properties Setting
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(3) Image Repeat
Prints two copies of the same page on one sheet.
o Off Default setting
* 2-Repeat Image Repeat is on.

(4) Paper Source
Selects the machine’s paper take-up tray to be used.
Allows you to set the Cover Page function and the OHP Interleaving function.
» Paper Source Select the paper take-up tray to be used.
The available paper sizes are determined by the types
of paper take-up trays installed in the machine.
Available settings: Auto, Manual Feed, Trayl to

Tray3, LCC
* Media Type Select the type of paper.
Setting values: Plain, Transparency (OHP),
Thick, Thin, Tab, Trace, and User
Define

« Detail of Paper Source
Make settings for the Cover Page function and OHP
interleaving function.OO p. 3-10

NOTE
Some paper sizes cannot be selected. For details, refer to the User Manual of the
machine.

TIPS
» Set the paper take-up tray in the Device Options Setting tab.
» The paper take-up tray used is displayed in green in the Printer Figure area.
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4. Setup tab

(5) Output Setting
Allows you to select the machine’s exit tray to which the paper is to be
distributed.
Settings can also be made for finishing functions, including stapling and
folding.
» Paper exit destination Select the machine tray to which you wish to
distribute the prints.
Not Installed Primary Tray
Finisher or Booklet Finisher
Primary Tray, Secondary Tray
* Detail of Output Setting
Make stapling or folding settings. For details, see
p. 3-12.

Chapter 3

NOTE
Some paper sizes cannot be selected. For details, refer to the User Manual of the
machine.

Properties Setting

TIPS
* Set the type of finisher in the Device Options Setting tab.
» The paper take-up tray used is displayed in green in the Printer Figure area.




Chapter 3

Properties Setting

3-10
4. Setup tab

Functions of the Detail of Paper Source dialog box

Allows you to make settings for the Cover Page function and the OHP Interleaving
function.

Detail of Paper Source 1
(1) :Euver Pag; o Interleaving Paper (2)
™ OHP Interleaving
I= | with Image I= | it mage
[So/En Baper Souse
IManua\ Feed j
™ Back Cover Page
I= it age
Back BoverEaner Source
[Marual Feed =

oK I Cancel Help

C4027P210CA

(1) Cover Page
Used to print a document with front and back cover pages. You can print on the
front cover or leave it blank.
* Front Cover Page Adds a front cover page.
 with Image (Front Cover Page)
Prints on the front cover paper.
» Back Cover Page Adds a back cover.
» with Image (Back Cover Page)
Prints on the back cover paper.
» Cover Paper Source/Back Cover Paper Source
Select the tray for the front and back cover papers.
Available settings: Manual Feed, Trayl to Tray3,
LCC

NOTES

* When using special paper, such as thick paper, the paper sometimes may not to
be distributed to the selected paper exit tray.

* Select the paper source for the body of the document from the Paper Source list.

* You can select Manual Feed, Tray 1 to Tray 3, or LCC for the body of the
document.

TIP
The tray containing the paper on which the body of the document is to be printed
is displayed in green in the Printer Figure area.
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(2) Interleaving Paper
Inserts sheets (interleaving sheets) between sheets of OHP film when printing
on OHP film. You can either leave these sheets blank or print the same image as
that printed on the OHP film.

* OHP Interleaving Inserts OHP interleaving sheets.
» with Image Prints on the interleaving sheet.
NOTES

* When using the OHP Interleaving function, set the number of print sets to “1”.

 Select paper source for OHP interleaves in the Paper Source list.

» “Manual Feed” cannot be selected as the paper source for interleaves.

* Only “Manual Feed” is available as the paper source for the OHP film. No
other paper sources can be selected.

* OHP interleaving and two-sided printing are not available simultaneously.

Chapter 3

TIP
The OHP interleaving tray is displayed in green in the Printer Figure area.

Properties Setting



Chapter 3

Properties Setting

3-12

4. Setup tab

Functions of the Detail Of Output Setting dialog box

Allows you to make settings for the finishing functions, including stapling and

folding.
[~ Stapl [~ Folding
1) ———— 5] ——— =) &
~ Punch -~ Cover Shest Mode
(2) - e I% arf hd E off vI
~ Trimming
i On
= 0ff
a9 I Cancel Help

(1) Staple (when the Finisher or Booklet Finisher is installed)

C4027P211CA

©)

(4)

®)

Allows you to staple one set of printed documents at a time.

 Right Corner

Upper 2-point

corner.

Printed documents are stapled in the upper right

Printed documents are stapled at two points along the
top edge.

Left Corner Printed documents are stapled in the upper left corner.

Left 2-point Printed documents are stapled at two points along the
left edge.

Right 2-point Printed documents are stapled at two points along the
right edge.

[l See p. 1-4 for an illustration.

NOTES

« If a Staple setting has been made, printed pages are fed out into the Primary Tray.

« If the capacity of the Finisher or Booklet Finisher is exceeded, the stapling
operation may be canceled. Refer to the User Manual of the machine.

stapling may be canceled.
» Take care when printing a document consisting of pages facing different

directions, since the stapling position will be determined by the direction of the

first page.
» Certain sizes or kinds of paper cannot be selected. For details, refer to the
User Manual of the machine.

If the original document for a print job consists of pages of different sizes,
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()

3)

(4)

(5)

Punch (when the Punch Unit is installed to the Finisher/Booklet Finisher)

Allows you to punch holes in the printed document.

o Off The document is not punched.

» Upper The document is punched along the upper side.

* Left The document is punched along the left side.

* Right The document is punched along the right side.

Folding (when FN-7 and ZK-2 are installed)

Allows you to select the desired paper folding function. ™

o Off Printed pages are not folded. )

 Z-folding Printed pages are folded into three parts with the E
printed surface inside. @)

* Fold Printed pages are folded once with printed surface
inside. =

» Center Staple + Fold Printed pages are stapled at the center and creased =
with printed surface inside. &

Cover Sheet Mode (when Cover Inserter C is installed) .§

o Off Cover sheets are not inserted. g

* Front Cover sheets are inserted in front of your job. o

» Back Cover sheets are inserted in the back of your job. o

* Front and Back Cover sheets are inserted at both the front and back of
your job.

Trimming (when the Trimmer Unit is installed to the Booklet Finisher)

Specify if you want to trim the pages of your booklet.
o Off The document is not trimmed.
* On The document is trimmed.
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5. Paper tab

5. Papertab

Functions of the Paper tab
Allows you to make basic printer settings.

@)

@)

®)
(4)

Minolta Pi8500Pro PCLE Properties K
Quality | Device Options Setting | Job Management | Overlay |
Geneial | Detals | ColorManagement | Shaing | Setup Paper
CEasySet————— | Orginal Document Si ~Copi
RS [441210 « 257 o) =l |1 :jllcﬂpy [1-6333]
Save... | Edit Custan... | Calats
- Output Paper Size el ) Uneallsted
B i P ) ol ated
k [ea 20w 257 o) 2 sotng—————————————
Scaling % Unsorted hd
=l 3
[ 00 Az s —
- Orentation——————————————————
~FulBreed————————————— & Potiai
Cin  Landscape
& off
Am —Wide Paper
" Prirter Figure off hd
0K | Cancel Al Help

(1) Original Document Size
Allows you to set the size of the original.

» Paper size

» Edit Custom

C4027P212CA

Select the size of the original.
Available settings: Letter, Letter-R, Legal, A3, A4,
A4-R, A5, A5-R, A6, B4, B5, B5-
R, Invoice, Invoice-R, 1417, F4-
1, F4-2, F4-3, F4-4
Used for special siz€s. p. 3-17

®)
(6)

@)

®

NOTES
» When using custom size paper, first load the sheets into the Manual Feed Tray,

and then select the paper size on the Touch Panel of the machine.

» When custom size paper is used, only one page can be printed on one sheet.
» Depending on the environment used, the number of registrations will be

different. 0 p. A-7

» The paper size setting made in the application may have priority over the

paper size setting made in the printer driver.

If the pages are not printed correctly, confirm the paper size setting for the

application.
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(2) Output Paper Size

Allows you to set the size of the paper on which prints are to be made.

» Output Paper Size Allows you to specify the size of the printing paper.

» Paper size Select the size of the printing paper.

Available settings: Letter, Letter-R, Legal, A3, A4,

A4-R, A5, A5-R, A6, B4, B5, B5-
R, Invoice, Invoice-R, 1417, F4-
1, F4-2, F4-3, F4-4

o™

* Fit to Paper The original is printed at a zoom ratio that matches ¥
the size of the printing paper. ‘%

 Scaling Specify the print zoom ratio. 5

Setting range: 25 to 400%
[0 See p. 1-3 for an illustration.

NOTES

« If you select a paper size not loaded in the machine, the machine will display a
message informing you of this.

If you specify a paper source and paper size that do not match the specified
tray, the machine will display messages showing that the specified paper size is
not correct and asking if printing should be executed forcibly.

If the Original Document Size setting does not match the size specified in the
application with “Fit to Paper” selected, the machine will use the paper size

set in the application.

roperties Setting

o

(3) Full Bleed
Specify if you want to print the pages with a full bleed.
o Off The document is not printed with a full bleed.
* On The document is printed with a full bleed.

(4) Wide Paper
Specify if you want to use wide paper.
o Off Wide paper is not used.
* On Select the size of wide paper used.
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5. Paper tab

(5)

Copies

Specify the number of sets of prints to be made. Either type the value directly
or press h]or[v].

Setting range: 1 to 9999 sets

NOTE
When using the OHP Interleaving function, set the number of sets of prints to
Hl”.
(6) Collate
This function is not available.
(7) Sorting
Select the sorting method.
 Unsorted Multiple copies of each page are printed.

(8)

For example, when five sets of copies are to be
printed, five copies are printed for each page. Prints
are not sorted.

» Sorted Copies are printed in document sets. For example,
when five sets of a 10-page document are to be made,
prints are sorted and arranged in five sets consisting
of the 10 document pages.)

* Group Multiple copies of each page are printed. Prints are
sorted by page.

Orientation
Select the orientation of the printout. You can check the selected direction in
the Page Layout area.

* Portrait Printing is done lengthwise.
» Landscape Printing is done crosswise.
TIP

A Portrait or Landscape print appears in the Page Layout area.
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5. Paper tab
Functions of the Custom Paper dialog box
Used to set special paper sizes.
)
Paper Mame : Paper Size :
Lo |
Cancel
2 2
(O]
©) I
Delete :I— (4) 5
Help |
4668P057CA .E‘
(1) Paper Name &
Select the name of the paper from the Paper Name list. .g
(2) New g
o

®3)

(4)

This function allows you to set a special size of paper. When it is selected, the
dialog box changes to the Custom Paper settings dialog box.
Number of registrations: Different depending on the environment used

O p.A-7
Edit
Edits the Custom Paper selection made in (1). When this is selected, the dialog
box changes to the Custom Paper settings dialog box.

Delete
Deletes the Custom Paper selection made in (1).
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Custom Paper settings dialog box

Custom Paper 2]
(5) Mame : INew Paper -1- oK. |
(6) R Cancel
fidth - IS 3: IB 3: ME Unit —I
[315/16 - 12 5/16] & inch Help |
Height : |11 3: |o 3; 416 o
[51341E - 18 0/1E]
C4027P218CA
(5) Name

Enter a name for the custom paper.
Setting range: Max. 20 characters

(6) Size
Set the paper size.
Setting range:
Width 3 15/16 inch to 12 5/16 inch (Unit set to “inch”)
100 mm to 314 mm (Unit set to “mm”)
Height 5 13/16 inch to 18 0/16 inch (Unit = inch)
148 mm to 459 mm (Unit set to “mm”)

(7) Unit
Allows you to switch between “inch” and “mm” for the paper size.

)
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6. Quality tab
Functions of the Quality tab

Minolta Pi8500Pro PCLE Properties 2]
General | Details | Color Management | Sharing | Setup | Paper |
Quality | Device Options Setting | Job Management | Overlay
(1) | Easy Set . Resalution

- [oozem =]
Save

& Page Lapout

" Printer Figurs

oK I Cancel el Help

C4027P213CA

(1) Resolution
Select the printing resolution.
Setting range: 608 600 dpi

Chapter 3

Properties Setting
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7. Job Management tab

7.

Job Management tab

Functions of the Job Management tab

(1)

(@)

Minolta Pi8500Pro PCLEG Properties 2]
General | Details | Color Management | Sharing | Setup | Paper |
Quality | Device Options Setting Job Management | Overlay |
(l) [ Easy Set - Securi i~ dob Owmer 2
- ™ Account Cods Default User Name ( )
Access Number : [0- 33333333]
Save
(3) ™ Lock Job
Password : o]
i l— JobSchedue
Job Life [Past Rip) : (4)
[or |

% Page Layout

€ Printer Eigure

aK I Cancel Ay Help

C4027P214CA

Account Code
Select this check box when using the copy track function. An account code is
attached to each printing job, enabling you to carry out management at the
machine. In order to use this function, copy track function must be set at the
machine.
When the copy track function is set at the machine, printing may sometimes fail
to take place until the access number designated at the machine is correctly set.
* Account Code Enable the Account function.
» Access Number Enter the password number set in the machine.

Setting range: 0 to 99999999 (8 digits)

Default User Name

The default user name set in the printer driver is displayed with Fiery LCD and
Web Spooler.

Setting range: Max. 8 characters
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7. Job Management tab

(3) Lock Job
Select this check box to lock a print job.
When using Lock Job, set a password in the Password box.
A locked printing job will be printed when it is unlocked using the Job List
display on the machine panel. In this case, a password is necessary.
* Lock Job Enable the lock job function.
» Password Enter the password of the locked job.
Setting range: 0 to 99999999 (8 digits)

« Unlocking a job

When the Lock Job function is set from the printer driver, printing can only take
place when the password is input from the machine.

After sending data, print from the machine.

1. Press the mode key on the control panel to enter Printer mode.

Print  Copy  Scan
O—Q@—@
L

C40270236AA

2. Touch the [Num] button.

3. Type the numeric password.

C4027P235CA

NOTES
« All jobs for which the original password and the input password match are
unlocked.

4. The job is unlocked and printing will start.

Chapter 3
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Chapter 3

Properties Setting

3-22

7. Job Management tab

(4) Job Schedule

Allows you to confirm and change any setting for a job after the print engine

stops.

o Off Default setting

* Wait The copier stops automatically before it prints the
received image.

* Proof The copier stops after printing a set of images of a

job.
e Job Schedule

If you print with “Wait” or “Proof” selected under “Job Schedule” in the printer

driver, the following screen will appear on the machine panel.

PRINTER CHECK. MODE [ BASIC MODE

W

1

Simplex

A4

Tray 1

-----

9 Face down

[ HDD_]
STORE

[

PROOF
PRINT

CExiT )

C4027P234CA

Make the settings you want, and then press the [Print] button to start printing.
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8. Overlay tab

Functions of the Overlay tab

Minolta Pi8500Pro PCLE Properties

General | Detals |  ColorManagement | Shaing Seup | Paper |
Qualiy | Device Dptiors Setting | Job Management Owerlay

(1) ~Fasy W
id <NONE> =

ey 1= |5t Page
Ecit Watermark

& Page Layout
© Printer Figure

1S I Carncel £oply Help

C4027P215CA

(1) Watermark
Prints a specific word in the background as a watermark.
o Text From the list, select the word to be entered as the watermark.
Available settings: NONE, CONFIDENTIAL, TOP SECRET,
COPY, DO NOT COPY, DRAFT, FINAL,
PROOF, or a word set by the user
» 1st Page Only Select whether to insert a watermark on only the first page
or on all pages.
» Edit Watermark Make format, position, and other settings for the watermark
characters[J p. 3-24

[0 See p. 1-4 for an illustration.

NOTES

* When using the Cover Page function together with this function set to “NONE”
and the watermark set to print on only the first page, the watermark will be
printed on the second page.

 This function may not work with some applications.

» Depending on the environment used, contents of Save/Delete will be different.

TIP
A view of the watermark will be displayed in the Page Layout area.

Chapter 3

Properties Setting
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8. Overlay tab

Functions of the Watermark dialog box
Allows you to set the text to be inserted with the Watermark function, and also the

text style.
— (1)
— (2
<NONE> \_ 3)
CONFIDEMTIAL
TOP SECRET Edit.. —} 4)
COFY
bo T coey oEEE— (5)
FADF ok |
Cancel I
Help I
4668P052CA
(1) Preview
Allows you to preview the watermark.
(2) Name

Select a watermark from the list.

Available settings: <NONE>, CONFIDENTIAL, TOP SECRET, COPY,
DO NOT COPY, DRAFT, FINAL, PROOF, user
settings

(3) New

(4)

(5)

Allows you to create new watermark text.

When you select this item, a dialog box for making detailed settings appears.
Edit

Allows you to edit text selected in (2).

When you select this item, a dialog box for making detailed settings appears.

Delete
Deletes text selected in (2).
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8. Overlay tab

Watermark detailed dialog box

Watermark EHE
~Watermark Edit
Name IWalermark Name (6)
(l) Stiing : |Walermark String (7)
—Font
Type Face: W (8)
o 72 = Peirt[B-200] 9)
Style - I Eold I ltslic (20)
Shading A =z [0 (11)
’Alﬂgl—iﬂ Position (12)
- & Center
UDs:g:::jng € Usger Setting (13)
m degres Haorizontal 1} _|:;‘
[-180 - 180] ertical : ] _Ij
oK I Cancel | Help I
4668P053CB
(6) Name
Enter the name under which you wish to register the watermark.
Number of registrations Different depending on the environment used
O p. A6
Number of characters Max. 20 characters
(7) String

Enter the text to be printed as a watermark.
Number of characters  Max. 63 characters

(8) Type Face
Specify a font for text to be printed as a watermark.
Specify a font from the fonts installed on your PC.

(9) Size

Specify the font size of the characters.

Setting range 8 to 200 points (in 1-point steps)
(10) Style

Specify the font style of the characters.

 Bold Prints bold characters.

* [talic Prints italic characters.

Chapter 3
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8. Overlay tab

(11) Shading
Specify the density of the characters.
Setting range: 5% to 100%

(12) Angle
Specify the angle of the characters with respect to the paper.
» Angle Default angle fixed by the driver.

Available settings: Horizontal, Diagonal, Vertical,

User Setting
» User Setting If you select “User Setting” from the Angle list, you
can set any desired angle.

Setting range: -180° to +180° (A — (minus)
value rotates the characters
clockwise, O leaves the characters
parallel to the paper, and a +
(plus) value rotates the characters
counterclockwise.)

(13) Position
Specify the position at which you wish to print a watermark.
» Center The watermark is printed in the center of the paper.
» User Setting You can specify a position by entering numbers in the

Horizontal and Vertical boxes.

Setting values:

Horizontal -999 to 999 points (in 1-point
steps)

Vertical -999 to 999 points (in 1-point
steps)

(72 points = 1 inch)
TIPS

 Specify the position from the center. The Horizontal positive direction is to the
right, and the Vertical positive direction is upward.
* You can view your settings in the Preview area (1).
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9. Conflicts dialog box

9. Conflicts dialog box

Functions of the Conflicts dialog box

A Conflicts dialog box like the one shown below appears when a setting that
conflicts with another made previously is made in a Properties tab.
When the following dialog box, the currently selected settings conflict with each other.

Conflicts

™

YYour current selections have caused the Following items to conflict B
with each other. =
Q

Itern Current Selection o]
<

OHF Interleaving On O

Paper Source : Auto

-

c

To automatically rezolve the conflicts as shown in the table below, E
click Resalve. <)
n

To return o the previous selection, click CANCEL. %)
[}

=]

b
Item Mew Selection 3
o

p—

Paper Source : Traypl o

Cancel |

4014P010CA

When the Conflicts dialog box appears, it shows the settings that cannot be
combined with each other. Check the details, and then click the [Resolve] button, or
the [Cancel] button to quit.

NOTE

Some settings, which are defined by the machine for restricted combinations of
different functions, can at times be accepted by the printer driver. If a print
command is issued from the personal computer with such settings made, the
machine will not produce the output correctly. Make sure that you choose correct
settings.

Tip
The dialog box looks slightly different from this one when the Device Options
Setting tab is being used.
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9. Conflicts dialog box
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1. Troubleshooting

1. Troubleshooting

Unable to print

This chapter explains the troubleshooting procedures for possible malfunctions.
Perform the troubleshooting procedures given below in the order listed when the
machine is unable to print even when you execute a print command from your

Chapter 4

Troubleshootin

computer.

Symptom

Possible cause

Action

The message “Printe
Error” appears on the

An error is present in the
machine.

Check the control panel of the
machine.

computer screen.

The network cable is dis-
connected.

Make sure that the network cabl
is connected properly to the
computer and controller.

Printing does not start
despite completion of

An error is present in the
machine.

Check the control panel of the
machine.

the printing setup on
the computer.

The network cable is dis-
connected.

Make sure that the network cabl

is connected properly to the con-

troller.

e

The printer driver selected
for printing is not for the
Pi8500Pro PCLS6.

Check the printer name selecte
in the Print dialog box.

A print job yet to be pro-
cessed is loaded in the
machine, causing the
printer to wait.

Check the job using Web
Spooler of Fiery WebTools.

Continued from the
previous page (Print-
ing does not start
despite completion of

The print job is locked.

Select “Printer” using the Mod
button on the control panel of th
machine. Enter the correct pass
word.

D

the printing setup on
the computer.)

The connection from the
controller to the network
has not been established.

Consult the network administra:
tor.

When E.C.M. (EKK.C.) is
used, an incorrect passwor

may have been typed.

Use the correct password.
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Symptom

Possible cause

Action

Multiple copy sets are
mistakenly sorted and
stapled together as a
single large set.

The settings in certain
applications may conflict
with the printer driver set-
tings.

In the application, turn off Col-
late and set the copy count to
“1". In the printer driver, make
the desired Sorting and copy
count settings.

A large number of
copies are mistak-
enly printed.

The settings in certain
applications may conflict
with the printer driver set-
tings.

In the application, turn off

Collate and set the copy count o

“1". In the printer driver, make
the desired Sorting and copy
count settings.

If the problem persists even after these checks have been made, refer to the

documentation for the machine.
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1. Troubleshooting

Unable to make correct settings / Unable to print exactly as set

Perform the troubleshooting procedures given below in the order listed when you
cannot make proper settings in the printer driver or when the print results do not
represent what has been set.

Symptom

Possible cause

Action

Unable to select an
item in the printer
driver.

Some functions cannot be
combined.

Do not select items which are
dimmed.

The Conflicts dialog
box is displayed on
the computer screen.

An illegal combination of
functions has been made.

Check the combinations and
make a correct combination of
functions.

Unable to print
exactly as set.

Incorrect settings are made.

The combination of func-
tions, though valid on the
printer driver, is invalid on
the machine.

Check the setting for each it
of the printer driver.

EM

The watermark can-
not be printed.

The watermark was not
correctly set.

Check the watermark setting.

The Shading setting of the
watermark is low.

Check the Shading setting of th
watermark.

Unable to specify
Staple.

Staple can be specified only Select the type of Finisher you

when the type of Finisher
you are using is selected i
the Device Options Setting
tab and “Primary Tray” is
selected as the Output Sett
ting in the Setup tab.

are using on the Device Option
Setting property sheet, and selg
“Primary Tray” as the Output
Setting in the Setup tab.

p

No stapling can be per-
formed in the following
cases: The specified is
Invoice-R, A5-R, A6, B5-
R, or Custom Size, an Out
put Setting other than “Pri-
mary Tray” is selected,
Booklet is specified, OHP
Interleaving is specified.

Check the paper size, Output
Setting, Booklet, and OHP Intef
leaving settings.
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Symptom

Possible cause

Action

Unable to staple
properly.

No stapling can be per-
formed on thick paper or
OHP transparencies.

Check the type of paper.

When the Finisher is
installed, no stapling can b¢
performed if the number of
prints to be made exceeds
50.

No stapling can be per-
formed if the number of
pages to be printed is 50 0
more when a Booklet Fin-
isher is mounted.

Check the number of prints to b
> made.

No stapling can be per-
formed if the original docu-
ment contains pages of
different sizes.

1%

The stapling position
is opposite to what is
expected.

The paper direction and N
up do not match the setting
made for Orientation.

Change the Orientation setting.
)

Folding cannot be
specified.

The optional Booklet Fin-
isher is necessary for you t
specify Folding. “Booklet
Finisher” must be selected
in the Device Options Set-
ting tab.

Select “Booklet Finisher” in the
b Device Options Setting tab.

Folding may be disabled
when Staple is specified.

Check the settings made. (See
“Function combination matrix”
on p. A-2.)

Folding is not per-
formed.

Folding cannot be per-
formed if tab paper or OHF
transparencies are used.

Check the type of paper.

Unable to print an
image properly.

The machine’s available
memory space is not suffi-
cient.

Add memory to expand the
machine’s memory space or sin
plify the image to reduce the

h

amount of data handled.
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1. Troubleshooting

Symptom

Possible cause

Action

Unable to specify the
exit port

No exit port can be speci-
fied if the paper size is A6

or Custom Size is specified.

Check the setting of the paper
size.

Paper is not fed from
the specified paper
source.

Paper will not be fed from
the specified paper source
if that paper source is
loaded with paper of a dif-
ferent size and orientation.

Load the paper source with pap
of the appropriate size and in th
appropriate direction.

pr

No watermark is
printed.

A watermark may not be
printed in graphics applica
tions.

No watermark can be printed in
this case.

Unable to print
exactly as set.

The paper size, paper orie
tation, and other settings
made in the application
take precedence over thos
made in the driver.

n-Make correct settings in the
application.

If the problem persists even after these checks have been made, refer to the
documentation for the machine.
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p Primary Tray
Setting Secondary Tray

Sorter

Front Cover
Back Cover
Trayl, 2,3
Manual Feed

Custom size
LCC

Unsorted

Sorted

Group
Copies (2-9999)

Duplex

B4
B5
B5-R
Fa4

Scaling (Not 100)

Full Bleed
OHP Interleaving

Output

Mode

Booklet
Image Repeat
N-up
Watermark
Fit to Paper
Wide Paper
Fold

Staple
Trimming
Cover

Page

Front

Cover

Tray

Lock Job
Account Number
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1. Function combination matrix

0 The combination is possible.
x  The combination is impossible.
(The settings made will be rejected.)

NOTE

* When the check box under Output Paper Size is not selected, the paper size
selected in the Original Document Size list will also become the Output Paper
Size setting.

» Cannot be used if the LCC rejects paper loaded in the portrait orientation.
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2. Number of registrations

2. Number of registrations

Number of registrations/Usable range for Easy Set

Windows 98/Me

Windows NT4.0/2000/XP

Registration Use Registration Use
S Printer icon - - ® 16/1 driver O
15}
k]
£
[S
o . .
< | Application - - x O
4 Printer icon - — X O
?
>
9]
2
(o)
o Application - - X O
Printer icon ® 16/1 driver O X O
<
Q
(2]
>
Application ® 16/1 driver O X O

X
©
c
)
Q
Q
<
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2. Number of registrations

Number of registrations/Usable range for Watermark

Windows 98/Me

Windows NT4.0/2000/XP

Registration

Use

Registration

Use

Administrator

Printer icon

* Total: 15

Common
Personal
[All users]
Personal

Application

Common
Personal
[All users]
Personal

Power Users

Printer icon

Personal
[Administrator]
Common

Application

Personal
[Administrator]
Common

Users

Printer icon

* Total: 22

Personal
[Administrator]
Common

Application

* Total: 22

Personal
[Administrator]
Common
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2. Number of registrations

Number of registrations/Usable range for Custom Paper

Windows 98/Me Windows NT4.0/2000/XP

Registration Use Registration Use

e Common
* Personal
* [All users]

Personal

Printer icon - — * Common: 16

e Common
* Personal
* [All users]

Personal

Administrator

Application - - x

* Personal
Printer icon - - X ¢ [Administrator]
Common

* Personal
Application - - X ¢ [Administrator]
Common

Power Users

* Personal
Printer icon ® 32/1 driver O X ¢ [Administrator]
Common

X
©
c
)
Q
Q
<

Users

* Personal
Application ® 32/1 driver O X ¢ [Administrator]
Common
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3. E.C.M. (EK.C)

Account Code

This function can only be accessed by the “key operator” after an 8-digit E.C.M.
master key code is entered. The E.C.M. allows you to monitor all copying activity

by controlling E.C.M. password accounts.

This feature can track copier usage for individual users and/or accounts as well as
limit access to the copier to authorized users. Copy quantity limits for specific
accounts can also be set. Use the E.C.M. Key Operator Form provided at the end of
this section to record E.C.M. password information.

The E.C.M. stores up to 1,000 E.C.M. passwords, each of which represents a
separate account that can be used for billing and recordkeeping. The number of
users assigned to each account may depend upon the billing system in operation and
the number of individuals and departments using the copier. When the E.C.M. is
activated, copying can be performed only after a valid E.C.M. password is entered.
Copy quantity and copy limit for each account can be visually confirmed on the
screen.

If E.C.M. needs to be activated on your machine, contact your service
representative.

The following E.C.M. settings can be made:

[1] E.C.M. data edit:
Change, add, or delete E.C.M. data and reset the copy count of the individual
account.

[2] E.C.M. all count reset:
Clear the copy count for all accounts.

[3] E.C.M. function setting:

Activate the desired E.C.M. functions and set the machine condition when the copy
limit is reached to stop either immediately or after a job is completed or to only
display a warning message.
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How to access the ECM setting mode

Key Operator Mode Screen ECM Master Key Code Screen

Enter E.C.H. master code

Key operator mode menu
Select one of following itens

Systen initial setting (_6) Paper type / Special size set

Copier initial setting Panel contrast/Key sound adj

User setting mode [ 8) Key operator data setting

E.C.M. function setting (9] Weekly tiner

Lock/delete program memory Control panel adjustment

PREYIOUS I I
CANCEL oK

C4027P219CA C4027P220CA

ECM Setting Menu Screen

E.C.M. setting menu
Select one of following items

PREYIOUS
SCREEN

C4027P221CA

Procedure

X
©
c
)
Q
Q
<

1. Touch “[4] E.C.M. function setting” on the Key operator mode menu screen.
The Enter E.C.M. master code screen is displayed if a code is required.

2. Use the keypad on the touch screen to enter your 8-digit E.C.M. master key
code, and then touch [OK] to display the E.C.M. setting menu screen. (See
note.)

3. Select the desired E.C.M. function, and then make settings as required.

4. To exit the E.C.M. mode, touch [PREVIOUS SCREEN] on the E.C.M. setting
menu screen, and then touch [PREVIOUS SCREEN] on the Key operator mode
menu screen to restore the basic screen.

NOTE

If an invalid E.C.M. master key code is entered, continue by entering the valid 8-
digit code. The E.C.M. master key code can be set to less than 8 digits with the
Memory switch setting of the Key Operator function.
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c
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[1] E.C.M. data edit
Use this function to display the list of copy count and copy limit for each account, to
change, add, or delete the E.C.M. data, and to reset the copy count for each account.
« E.C.M. No. Designated by key operator
» E.C.M. Password
Unique 8-digit numeric code programmed by the key operator
for user
» User Name Max. 8 characters
» Copy Limit 0 to 999,999 copies

ECM Setting Menu Screen ECM Data Edit Screen
E.C.M. setting menu E.C.H. data <Edit>
Select one of_fo!lou_tin_ itens I No. 0001
(Jecnmacoi ]
- -SEIKO--  000000/012345 ¢ add
-TAKUYA-  000000/001234 =
. -OHIRA-- 000010/000010 &
e )
C4027P221CA C4027P223CA

ECM Data Change Screen ECM Data Add Screen

E.C.M. data <Change>

00000000
-

CANCEL I oK I CANCEL I oK I

C4027P224CA C4027P225CA
Password Duplication Screen Name Duplication Screen

=

_—.|

C4027P226CA C4027P227CA
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Procedure

1. Touch [4] E.C.M. function setting on the Key operator mode screen. Enter an 8-
digit E.C.M. master key code, and then touch [OK] to display the E.C.M. setting
menu screen.

NOTE:

If an invalid E.C.M. master key code is entered, continue by entering the valid
8-digit code.

2. Touch [1] E.C.M. data edit. The E.C.M. data Edit screen will be displayed.

3. To change, add, or delete the E.C.M. data, and to reset the copy count of an
account, follow the procedure described below for each account.

To change E.C.M. data:

(1) Touch the arrow keys on the right side of the list to highlight the E.C.M. data to
be changed, and then touch [Change]. The E.C.M. data Change screen will be
displayed.

(2) Touch the desired item key to highlight it, and then enter new data by using t 33<
touch screen keypad. o)
Password Max. 8 digits (See note 1.) e
Name Max. 8 characters (See note 2.) <
Limit Max. 999,999 copies
NOTES:

1 We recommend that you make a list of all E.C.M. passwords and account
numbers.

2 If an invalid user name is entered, continue by entering the valid name.

(3) Touch [OK] to complete the setting and to verify whether the same password or
name has already been used for another account number.
When a password is duplicated:
The duplicate password screen will be displayed. Touch [YES] to enter a new
password or [NO] to create a duplicate password.

NOTE:

If a duplicate password is created, the number of copies will be counted only
for the E.C.M. password with the smallest number. We recommend you do not
use duplicate E.C.M. passwords.

When a name is duplicated:
The duplicate name screen will be displayed. Touch [OK] to re-enter new
name.
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To add E.C.M. data:

(1) Touch [Add] on the E.C.M. data Edit screen. The E.C.M. data Add screen will
be displayed.

(2) Touch the desired item key to highlight it, and then enter the data by using the
touch screen keypad.

Password Max. 8 digits (See note 1.)

Name Max. 8 characters (See note 2.)

Limit Max. 999,999 copies

NOTES:

1 We recommend that you make a list of all E.C.M. passwords and account
numbers.

2 If an invalid user name is entered, continue by entering the valid name.

(3) Touch [OK] to complete the setting and to verify whether the same password or
name has already been used for another account number.

When a password is duplicated:
The duplicate password screen will be displayed. Touch [YES] to enter a new
password, or [NO] to create a duplicate password.

NOTE:
If a duplicate password is created, the number of copies will be counted only

for the E.C.M. password with the smallest number. We recommend you do not
use duplicate E.C.M. passwords.

When a name is duplicated:
The duplicate name screen will be displayed. Touch [OK] to enter a new name.

To delete E.C.M. data:

(1) Touch the arrow keys on the right side of the list to highlight the E.C.M. data to
be deleted, and then touch [Delete]. The delete confirmation screen will be
displayed.

(2) Touch [YES] to delete or [NO] to cancel.
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To clear the E.C.M. count:

(1) Touch the arrow keys on the right side of the list to highlight the desired E.C.M.
data, and then touch [COUNT RESET]. The reset confirmation screen will be
displayed.

(2) Touch [YES] to clear the copy count of the selected E.C.M. data or [NO] to
cancel.

Delete Confirmation Screen Reset Confirmation Screen

COUNT PREVIOUS PREYIOUS
RESET SCREEN SCREEN

C4027P228CA C4027P229CA

4. If other E.C.M. setting changes are required, touch [PREVIOUS SCREEN] on
the E.C.M. data Edit screen to return to the E.C.M. setting menu screen. Tou(
the desired key from [1] to [3].

5. Touch [PREVIOUS SCREEN] to restore the Key operator mode menu scree

Appendix

6. If no further changes are required, touch [PREVIOUS SCREEN] to restore th
basic screen for performing copy operations.
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[2] E.C.M. all count reset
Use this function to reset the count for all E.C.M. counters.

ECM Setting Menu Screen ECM All Count Reset Screen

E.C.H. setting menu
Select one of following itens

C)ech gtaeait R

E.C.H. setting
Reset all E_C.M. counters

[2) E.C.Mall count reset - -
- E.CM. function setting  Jiit il R EE R

PREVIOUS PREYIOUS
SCREEN SCREEN

C4027P221CA C4027P231CA

Procedure

1. Touch [4] E.C.M. function setting on the Key operator mode menu screen. Enter
an 8-digit E.C.M. master key code, and then touch [OK] to display the E.C.M.
setting menu screen.

NOTE:
If an invalid E.C.M. master key code is entered, continue by entering the valid
8-digit code.

2. Touch [2] E.C.M. all count reset. The Reset all E.C.M. counters screen will be
displayed.

3. Touch [YES] to reset all counters to zero and to return to the E.C.M. setting
menu screen.
Or touch [NO] to cancel. Touching [PREVIOUS SCREEN] will also cancel this
function and return to the E.C.M. setting menu screen.

4. If other E.C.M. setting changes are required, touch the desired key from [1] to

[3].
5. Touch [PREVIOUS SCREEN] to restore the Key operator mode menu screen.

6. If no further changes are required, touch [PREVIOUS SCREEN] to restore the
basic screen for performing copy operations.
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[3] E.C.M. function setting

Use this function to turn E.C.M. on or off and to select whether the machine will
stop when the count limit is reached or the copier will complete the copy job before
stopping when reaching the maximum copy count.

ECM Setting Menu Screen ECM Function Setting Screen

E.C.M. setting menu E.C.M. function setting
Select one of following itens

T

s
n settin

PREYIOUS
SCREEN

C4027P221CA C4027P233CA

Procedure

1. Touch [4] E.C.M. function setting on the Key operator mode menu screen. Enter
an 8-digit E.C.M. master key code, and then touch [OK] to display the E.C.M.
setting menu screen.

NOTE:
If an invalid E.C.M. master key code is entered, continue by entering the valig
8-digit code.

X
©
c
)
Q
Q
<

2. Touch [3] E.C.M. function setting. The E.C.M. function setting screen will be
displayed.

3. Touch [E.C.M. On] to activate E.C.M. or touch [E.C.M. Off] to deactivate
E.C.M.
The selected key will be highlighted.

4. Touch [Immediately] to stop the machine at once when the copy limit is reached.
In this case, copy conditions selected for the current job will be cleared. To
continue the job using the same user password, change the copy limit of the
password or clear the copy count.

Touch [After job] to stop the machine after the current job is completed when
the copy limit is reached.

Touch [Warning] to only display a warning message when the copy limit is
reached.

The selected key will be highlighted.

5. Touch [OK] to complete the setting and return to the E.C.M. setting menu
screen.

6. If other E.C.M. setting changes are required, touch the desired key from [1] to

[3].
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7. Touch [PREVIOUS SCREEN] to restore the Key operator mode menu screen.

8. If no further changes are required, touch [PREVIOUS SCREEN] to restore the
basic screen for performing copy operations.
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